» Agenda and Intro

- A brief intro to basic concepts

- Why things work the way they do

- Assume you are familiar with RTOSs and MQX
- Real work: hands-on labs

- Create a project, add the MQX Lite component
- Create tasks, watch the flashing lights
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Abstract

UART.

- We got most of it...

2 “freescale-

- You will use Processor Expert (PEx) to configure MQX Lite
(a PEx component) and initialize multiple tasks on the L
series processor. Light the LED and print message from
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General Impact of MQX RTOS

Adding ~450 new users every month
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MQX Lite — Overview

- Very light MQX kernel for resource-limited MCUs
- Targeted at the Kinetis L family initially
- Packaged as a Processor Expert component

- 1/O capability provided by Processor Expert
- USB via FSL bare-metal stack, also a Processor Expert component
- No file access

- Programming model allows upward code migration
- Code built with MQX Lite should move to full MQX RTOS easily
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MQX Lite — Main Features

- Scheduler
- Priority pre-emptive schedule
- Support for lightweight semaphore, and mutex (with polling)

- Task Management will not support dynamic task creation
- All task resources allocated at compile time

- Lightweight events and messaging only
- Dynamic memory management not allowed

- Lightweight timer included (one shot, and periodic notification)
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How Small Is MQX Lite?

- Minimal App — Hello Task, Idle task, interrupt stack

- Code = 10.4K
- Data = 3.7K (including 1.5K for stacks)

- Typical App — 7 tasks + idle, lightweight events, queues
- Code = 27K
- Data = 10K (5K for stacks)

- Your mileage will vary
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MQX Lite and Processor Expert Integration

% *Component Inspeckar - MoKl &5

- MQX Lite delivered as an RTOS adapter
- Interrupt mechanism in MQX is unchanged
- Processor Expert LDDs work with the RTOS

Properties . Methods | Events

Marme

Component narme
MQE wersion
Copy source files to project
Svskem timer
= Task template list

- The entire I/O from standard MQX

= Taskl

remov Ed Task settings
. ask

- 1/0O provided by LDD components T o settings

= Configuration Parameters
= Synchronization objects
Semaphores
Mutexes
Lightweight Events
= Interrupts
Inkerrupt Stack size
Use Idle Task
= Manage allocated interrupts
First allacated inkerrupt
Last allocated inkerrupt

- Set up and configure tasks in
Component Inspector

- Easy to add MQX Lite to existing app
- Just drop in the MQX Lite component
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Enough Talk, Time to Work

- Create a workspace
- Import a project
- Add and configure the MQX Lite component
- Define a task and write the code
- Add and walk through PEx components
- Using templates (this is way cool if you aren’t familiar)
- Build it and run it —watch the blinking lights
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Set CodeWarrior to a new workspace

This makes sure we don’t have any confusion
- File->Switch Workspace—->Other

* Warkspace Launcher

Select a workspace

Codewarrior Development Studio stores vour projects in a Folder called a workspace,
Choose a warkspace Folder ko use Faor this session,

Warkspace: D\ MOLikesorkspace| VH Browse. ..

¢ Copy Settings

@:‘ [ O, ] [ Cancel

Type in d:\MQXLiteWorkspace
For the sake of others, turn off “Use this as the default...”
Then you can hide the Welcome Screen that appears.
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+ Project Creaki

Import the starter project S @

Eug Import project
f‘{j Import exampléssroject

C C“Ck |mp0rt PrOJeCt |n Commander VIEW E2g Impart MCU executable file

% Mew MCU project

- File=>Import->General->EXxisting Projects Into Workspace

r ﬁb Import | (= P |

- Select root directory Import Projects B

Select a directory to search for existing Eclipse projects.

° C \d d |S k\WO rk\p I’Oj ect\L 1 PT @ Select root directory:  \project\L1PT\FAE training L series\Mayx_starter
() Select archive file: Browse..

\FAE training L series\Mqgx_ starter

Projects:

Mae_starter (Chd diskhwork project\LLIPT\FAE training L series\M: Select All

Deselect All

[T] Copy projects into workspace
Working sets
[] Add project to working sets

Wforking sets: Select...

@ Nets || Finish || Concel |
£
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Open Processor Expert project

This takes a few second on first launch

1 CodeWarrior Projects =3 — 0O
B | El 5, | File Name =~
. . File Mame Build
Double click the .pe file 4 &S Maustarter : FLASH
+ = Documentation
[= FLASH

. [ Generated_Code
’% ProcessorExpert.pe

The Components view opens & Project Headers

> [ Project_Settings

- New Ul in 103 + == Sources
- No longer called “Project Panel”

| h h h ts. Components - Mox_starter 23 =0
- No onger S ares.t e sa}me space as the CESa "~
CodeWarrior Projects view Project is not opened yet.
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Add the MQX Lite Component

- Go to Library, Categories, Operating Systems
- Double-click MQXLite

% Compon ot - MOxLibe % Components Library 23
Cateqaries Alphabetical | Assistant | Processors

Carnponent
[= Board Support
[=> CPU External Devices
== CPU Internal Peripher
[== Logical Device Drivers
[=)-[= Cperating Syskems
08| Earehoard
EB FresnTOS
B8] mcy Double
W8| rsDemal :
= click
@ i3 MO Like Realkime Operaking Syskem i
= 5w
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Examine CPU Component

- Provided and configured in starter project

- Select CPU, go to component inspector, look at System Clock

- 48 MHz

CodeWarrior Projects &3

az| B & & | File Name

le Name Build
1= Mepe_starter : FLASH

= Documentation
(= FLASH

[+ Generated_Code
% ProcessorExpert.pe
[= Project_Headers
[ Project_Settings
[ Sources

- Components - Maop_starter &3 =0

== - T

[= Generator_Configurations B
# FLASH

= 05 3

[~ Processors

+ 4 Cpu:MKL25Z128VLK4

[= Compenents

® £

» 16| BLUE:BiIO_LDD[FRED_KL25Z_LEDRGE_

z " freescal-

I I

-

= 0 % Components Library % Component Inspector - Cpu &2

Properties . Methods| Events | Build optiens | Used

Mame Value

MCG mode PEE
MCG output [MHz 26.0
MCG external ref, ¢ &0

4 FLL settings
FLL module  Disabled
FLL output [MF 0.0

4 PLLO settings
PLL module  Enabled

PLL output [MF 96.0

Initialization priority interrupts enabled

Watchdog disable yes
» CPU interrupts/resets
4 Clock configurations 1

4 Clock configuration 0

4 Clock source setting cenfiguration 0

MCG mode PEE
4 System clocks

Core clock 480

Bus clock 240

4 TPM clock selection  Auto select
Clock frequency [M 480

Details

96 MHz
8 MHz

0 MHz: FLL is disabled.

96 MHz

48 MHz
24 MHz
PLL/FLL clock
48 MHz

O LU ST T S T PO P T O T TSP C LIV O C TS O SO T e s



Configure System Timer

- The MQX Lite Component depends on a timer —which
must synch with the system

1 CodeWarrior Projects 1 — O/|%Y Components Library | %Y *Compenent Inspector - SystemTimerl i

i 1 | BB 1 |File Name Properties . Methods | Events
ile Name Build Name Value Details
[ ]
freq uen Cy > M starter : FLASH Module name SysTick SysTick
=48 MHz (= Documentation Counter SYST_CVR SYST_CVR
(= FLASH Counter direction Down
(£ Generated Code Counter width 24 bits
% Processorbxpert.pe Value type Optimal uint32_t
(= Project Headers 4 Input clock source Internal
(= Project_Seftings Counter frequency 48 MHz 48 MHz
(= Sources 4 Counter restart On-match
Period device SYST_RVR SYST_RVR
Period 5ms 5ms
= 4 Interrupt Enabled
- Components - M starter 4 . Interrupt priority medium priority 2
=R=N n - T Channel list 0

8 MQXL:MQXLite A 4 In'rtializatioq -
@) SystemTimerL:TimerUnit_LDD[MQ}| | Enbledininit.code | no
E] Taskl:MQXLite_task[ MO xLite! Tazk Auto initialization no

H]
B _int_default_isr
M _int_disable
IH _int_enable

M| _int_exception_isr %
m b

: I
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s Event mask

L £

Ready Play, SafeAssure, the SafeAssure logo, SMARTMOS, TurboLink, Vybrid and Xtrinsic are trademarks of Freescale Semiconductor, Inc. All
other productor service names are the property of their respective owners. © 2012 Freescale Semiconductor, Inc




Configure the Component

- We will have two tasks, so increase by one

T CodeWarrior Projects &2 -

l""z‘ B & P |File Name ¥

. Task Template FieName Build

List=3

- Other values
are default

L £
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15 Mep_starter : FLASH
[~ Documentation
[= FLASH
[= Generated_Code
% Processorbxpert.pe
[= Project_Headers
[= Project_Settings
[~ Sources

&. Components - May_starter &1 -0
=R -3 T
4 EJ MQXL:MQKLite -

o SystemTimerl:TimerUnit_LDD[MQ) |
s EJ Taskl:MQxLite_task[MOxLite\ Task
P @J Task2:MQ¥Lite_task[MO XLt Task
s EJ Task3:MQxLite_task[MO XLt Task
M _int_default_isr

—_—

15

Properties Methodq Ei.rentq

%Y Components Library |‘§§ *Component Inspector - MQXL 22

MName

Cornponent name
MQX version
Copy source files to project
System tirner
4 Task template list
4 Taskl
Task settings
4 Task?
Task settings
4 Taskld
Task settings
4 Configuration Parameters
4 Synchronization objects
Semaphores
> Mutexes
Lightweight Events
4 Interrupts
Interrupt Stack size
Use Idle Task

a Manana allnratad intarrntc

Value Details

Ml
mox 1 0
yes
Systemn Tirner
3
Enabled
Task
Enabled
Task
Enabled
Task

yes
no
no

1024 D

yes

furtnrnatiralhe
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Configure the First Task

- Select the task

Lo- WOMPOoNENTs - IVIQX_STAIer (- =

== - T

] ] 4 0§ MQX1:MQXLite =
o Exam|ne the proper’“es 3 SystemTimerL:TimerUnit_LDD[MQ2 |

» EJ Taskl:MQkLite task[MQXLite\ Task
s @J Task2:MQXLite_task[MOxLite\ Task
s EJ Task3:MQXLite_task[MOxLite\ Task

- Actually, default values for %'Qﬂi'jffféﬁ'i‘i” ]
all properties - -

’% Components Library % *Component Inspeckor - Taskl &3

« Task 1

Properkies - Methods | Events

- Name = Task1 (default) .
Marne Walue Dekails

= Case matters! Name Taski
Code depends on this Entry point funckion Taskl _task
_ _ Stack size 1024 D|
- Entry point function Priority 3 D|
. i_reation parameter 1]
- StaCk Size = 1024 Attributes
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Configure the Second Task
o5, Components - Mox_starter 23 =0
=R-2=1 T
4 M8 MQX1:MQXLite

1) SystemTimerl:TimerUnit_LDD[MQ)|_|
- Task?2 @ . 8] Task1:MQXLite_task[MOXLite\ Task

' EJ Task:MQxLite_task[MOQxLite Task

- Name = Task?2 (Defau|t) > %JTaskS:MQKLite_task[[‘-ﬂQ'xLitE' Task:
_int_default_isr
= Case matters! Code o =
depends on this
Marme Yalue Details
—_ Prlorlty = 9 Mame Task?
Entry point function Task?_task
-AUTO_START_TASK = s o
Creation parameter ]
En able 4 Attrihutei
L. . MK _AUTO _START_TASK Enabled
= we will instantiate and MQX_FLOATING_POINT_TAS! Disabled

start the task in our code
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Configure the Second Task
7. Components - Mop_starter &7 =08

== i I T

4 T8 MQXL:MQXLite

. TaS k3 ) SystemTimerl:TimerUnit_LDD[M Q|
s EJ Taskl:MQXLite task[ MO xLite"\Task
_ Nam e = TaS k3 (Defau It) @\> M8 Task2:MQXLite task]MOXLite! Task
s EJ Task3:MQxLite task[MOQXLite\Task

= Case matters! Code %'ZEL'EJTI:';J:“" ]

depends on this a ;

P
% Components Library (’% *Component Inspector - Task3 &3

- Priority =9 e s e
-AUTO_START_TASK = Nome Value Detais

Mame Task3

D|Sab|e Entry point function Task3_task
Stack size 1024 D
D

= we will instantiate and Priority g

. Creation parameter ]
start the task in our code 4 Attributes
MOQX_AUTO_START_TASK Disabled
MOQX_FLOATING_POINT_TASI Disabled
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Build the Code

Just click Build in the Commander view OR...

£ Commander 23 =~ = O
+ Select the project ion * Build/Debug e
; @, Build (Al e
. Project->Build Project le project # il il
xecutable file %% |Buid LED_KLZSZ (ALT+E,E) |
jE':t w Gpbrinne

Should be no errors

L £

Z “freescale"




Code Walk Through: Initialize the OS

Open ProcessorExpert.c
RTOS initialization — auto generated code

118' fEF* RTO3 startup code. Macro PEX RTOS START is defined by the RTOI o
112 #ifdef PEX RTOS START

120 PEX RTOS START() f7 Startup of the selected RTOI.
121 Hendif

1zz2 f%%#+% End of RTO3 startup code., %%/

That Macro = a call to _magxlite() — which sets up the OS

k| MK 5
TH/ST MO Lite start function */

ﬁ e LT MPEY RTOS START() ([ mogxlitel) )
=
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This code creates the tasks — mqxlite.c

[B] Mc%1.h te) mgdite.c £

266 _mogH uint  mgxlite (void)

ZET{ /% Body ¥/

Z65 EERMEL DATA STRUCT FTR kernel data;
69 NOXLITE TASK TEMPLATE STRUCT PTR template ptr;
270 TD_STRUCT PTE td_ptr;

Z7a _GET_EEFMEL DATA(kernel data):;

Z 74 f* Start Tick timer 7
275 HoXL ITE_RTOS_ILD AFPTE R_S ¥3TE I'I_TII'IE R_STILRT (WMULL]) ;

277 | /% Create the idle task */ |

275 #if MOX TU3SE IDLE TASKE

279 td ptr = task _init internal { (MQILITE TA3E TEMPLATE STRUCT PTR) &kernel data->IDLE TASE TEMPLATE,
250 kernel data->ACTIVE PTR->TASE ID,

251 fuint_32)0,

252 FALLSE,

283 fpointer)kernel data->IDLE TASK TEMPLATE.TAZK STALCEADDE,
254 [ mem size)kernel data->IDLE TASE TEMPLATE.TASE 3TACESIZE):
285 #if MoX CHECE ERROR3

2586 if (td ptr == NULL) {

287 _mgx_exit (MoE OUT OF MEMORY) ;

230 }o4¥ Endif v

259 #endif

Z80 _rtask _ready internsal (td ptr):

291 #endif

293 I ;% Check here for suto-create tasks, and create them here *.fl

234 template ptr = kernel data->INIT.TAZE TEWMPLATE LI3T:

295 while (template ptr->TASE TEMPLATE TNDEX) |

296 if (template ptr->TASE ATTRIBUTES & MQX AUTO 3TART TASE) |

237 td prr = task_init_internal (template_prr,

295 kernel date->LCTIVE PTR->TASE ID,
299 template ptr->CREATICN PARAMETER,
300 FALSE,

P 301 [pointer) tewmplate ptr—>TASK STALACELDDE,
0 302 [ mem size)ltemplate pbtr->TASE STACESIZE) ;
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Task templates generated from component

L7 MPA TasK Template L15T 77

. Open taSk_template_“StC 33 const TASK TEMPLATE STRUCT ﬂqx_template_list[] =

4
. 5 /% Task: Taskl */
- —in Generated_Code folder - :
- 17 /* Task number f/ TASK1 TASK,
'8 /* Entry point */  (TASK_FPTR)Taskl_task,
9 J* Stack size f/ TASK1 TASK STACK SIZE,
@ /* Task priority £4au,
i1 /¥ Task name #f Mtaskl",
° Here are our taSkS 2 /* Task attributes “/  (MQX_AUTO_START TASK),
13 /* Task parameter */ {uint32_t}{@}|
- Based on the properties set .. ...
. iB
N the Component 57 {*: Task number "/ TASK2_TASK,
8 /* Entry point */  (TASK_FPTR)Task2_task,
-One is an auto-start task as |} /. 72" =i gy TSRS
/* Task priority Joau,
11 11 /* Task name #f "task2",
we SpeCIerd b2 /* Task attributes “/  (MQX_AUTO_START TASK),
12 /* Task parameter f (uint32_t)(e)
B,
15 /% Task: Task3 */
wof
7 /* Task number f/ TASK3 TASK,
B /* Entry point */  (TASK_FPTR)Task3_task,
1o J* Stack size f/ TASK3 TASK STACK SIZE,
@ /* Task priority £4au,
3L /* Task name £/ Mtask3v,
32 /* Task attributes (e,
i3 /* Task parameter £ (uint32_t)(e)
= L

L £
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Task1 Code

In mgx_tasks.c

Function header
automatic

- You will still need to create
body of function obviously

Loops endlessly flashing
BLUE LED

“freescale"

38 Returns Nothing

30 #* ==zzz=sss===sssssssssssssssssssssssaes
40 */

41 void Taskl task(uint32 t task init data)
424

43 int counter = @;

44 printf("task 1 start running!in");
45 while(1) {

46 counter++;

47

43 /* Write your code here ... */
49 BLUE Clrval(e);

58 _time delay ticks(58);

51 BLUE_Setval(e);|

52 _time delay ticks(58);
53}

54

35
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Task2 Code

62 ** .'-'.Q:‘){ task routine. The routine is generated into mgx_tasks.c
B3 ** file.
- Loops endlessly = e o
task init data -
fIaShIng GREE ES Retu*zsk_lnl:_g:tﬁing

. Setup task3 s

78 void Task2 task(uint32 t task _init data)

714

72 int counter = 8;

73 _task_id task_id;

74 printf("task 2 start running!‘n"});

75 task_id = _task_create_at(®,TASK3 _TASK,18,Task3_task stack,TASK3 _TASK_STACK SIZE);
76 if ( task_id == MQX_NULL_TASK ID )

77 |

78 printf("task3 create fail!\n");
79}

3a

81 while(1) {

82 counter++;

83

84 /* Write your code here ... */
85  GREE_Setval(e);

86 _time_delay ticks(5@);
87

88 GREE_Clrval(@);

89 _time_delay ticks(5e);
90}

91 }

- The OS handles task priority and switching
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Task2 Code

- Loops endlessly sore | ThK tesk routine. The routine is gen

. B ** file.

fIaShIng RED Bl ** Parameters
a2 = MAME - DESCRIPTION
B3 ** task_init data -
B ** Returns : Nothing
BE *F cooo====ss=====s=s==s===s==s=======s===========
Be*/
27 vold Task3 task{uint32_t task_init data)
e8|

89  int counter = 8;
A8 printf("task 3 start running!in™);
A1 while(l) {

12 counter++;

A3

14 /* Write your code here ... */
15 RED Clrval(e);

16 _time_delay ticks(5@);
17 RED SetVal(@);

18 _time_delay ticks(5@);
19 1}

20}

21

22 /* END mgx_tasks */

- The OS handles task priority and switching

L £
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Download

Run->Debug As->CodeWarrior Download
- Pick the P&E Tracelink configuration

Debug perspective appears

Code stops at first line of main()

¥ select Co nﬁguratiomglﬂl#

Select a configuration t h

[E] Mop_starter_FLASH_OpenSDa
E Map_starter_FLASH_Segger J-Link_Trace
[ ] Mape_starter_FLASH_PnE U-Multilink

2
A
| @

Set a breakpoint at line 132 of mgx_tasks.c

“freescale"
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/* Write your code here ... */
BLUE_Clrval(e);
_time_delay ticks(58);
BLUE_SetVal(e);
_time_delay ticks(5@);
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Run

. ﬁDehug 2
- Click the Resume button Dl m L

= [c| LED_K&0_FLASH_OSITAG }%ﬁmmmlnnwnlnad]
= ARM Processors, LED, RE%”TE,,{F.@ d)

[=1

= # Thread [ID: 0x0] {Suspended: Signal ‘'Halk' re

° Resume eaCh t|me yOU StOp (€)= Yariables 273 8 Breakpoints | [J Cache | 318 Registers
- You'll see the count variable

increase, and the lights on the | ™™ Zoe
{(>)= task_param 1937006955
board flash (- task?_court 2

- Remove the breakpoint to run
the app without interference

- Right click, Toggle breakpoint

® £
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All Done

Click the Terminate button

%5 Debug 2
D 0 Sl2erI| >
4 E Mox_starter FLASH_OpenSDA [CodeWarrior Download)

- You have built an app using
-the MQX Lite component and PEX
- Adding a PEx component template

- You should understand some of the key differences between
MQX RTOS and MQXLite

- Now — if there’s time, for more fun
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